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FINITE ELEMENT ANALYSIS OF A PLANAR TRUSS 

Instructor: Professor James Sherwood 

Revised: Dimitri Soteropoulos 

Programs Utilized: Abaqus/CAE 6.11-2 

Problem Description: 

This tutorial explains how to build and analyze a planar truss. The pre-processing program used is 

Abaqus/CAE, and Abaqus command is used for the analysis.  

The geometry of the truss section is shown in Figure 1.  

 

Figure 1. Truss Dimensions and BC’s 

As seen in Figure 1, a pin connection will be used to constrain the right side of the truss, and a roller to 

constrain the left side.  
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Creating the Model Geometry 

 Go to the Start Menu and open Abaqus CAE 

 You may be prompted with an Abaqus/CAE 6.11 Start Session box (Figure 1). Close this box by 

clicking the X in the top right hand corner.  

 

Figure 1. Abaqus/CAE 6.11 Start Sesssion box. 

 Once the Start Session box is exited, the Abaqus/CAE Viewport should look similar to Figure 

2. (Please note the model tree is the series of functions listed on the left hand side of the 

viewport, while the module is the list of icons to the right of the model tree) 

 

Figure 2. Abaqus/CAE Viewport 

 To create the model geometry of the planar truss, a series of points and lines must be 

generated.  

Model Tree 
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 Using the left mouse button, double click Parts in the model tree and the Create Part 

(Figure 3a) dialog box appears. Enter a new name for the part (TRUSS), and under the Base 

Feature tab choose Wire for shape (as in wireframe) and Planar for type. The Create Part 

dialog box should look identical to Figure 3b. 

 Click Continue… and the graphics window will change to a set of gridlines.  

                                                            
     Figure 3a. Create Part Dialog Box      Figure 3b. Create Part Dialog Box (Truss) 

 

 For the first step in generating the model geometry, seven isolated points must be created. 

Click the Create Isolated Points icon    in the module. (Remember, the module is the 

series of icons to the right of the model tree) 

 On the bottom of the Viewport, a Pick a point—or enter X,Y: option can be seen. This 

“enter X,Y” option will be used to enter the x and y coordinates of generated points.  

 Enter the points given in Table 1; press enter on your keyboard after each point entry. You 

will see each point appear on the screen after it has been entered.  

Table 1. Point Coordinates 

Point X Y 

1 0 0 

2 20 0 

3 40 0 

4 60 0 

5 15 10 

6 30 20 

7 45 10 

 

 After all the points have been entered, click the red X button once. The X button is located 

in the bottom left hand corner of the viewport.  

 If all the points cannot be seen in the Viewport, click F6 on your computer keyboard to 

auto-fit the window to the contents.  After auto fitting, the screen should look similar to 

Figure 4. 
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Figure 4. View of Seven Points 

 The last step in creating the model geometry is to generate lines between the points, thus 

completing the truss network.  

 Click the Create Lines: Connected icon   in the module, it is located directly to the right of 

the Create Isolated Points icon.  

 With the cursor, click two individual points to create a line between them. A total of 11 lines 

should be generated in this model. (Please note, when the last line is created, the line 

feature is exited by clicking the Esc key on your computer keyboard.) 

 NOTE:  If you accidentally create an unwanted line, you can select Edit > Delete from the 

dropdown menu at the top of the screen and use the mouse to select a line to delete. 

 After the lines have been generated, click Done. 

 Sketch mode will automatically be exited, and the model geometry should look identical to 

the truss shown in Figure 5.  
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Figure 5. Final Model Geometry 

Defining Material Properties 

 To define material properties for this model, double click on Materials in the model tree and 

the Edit Material dialog box will appear (Figure 6a). Enter a Name for the material (STEEL), 

and click the Mechanical tab, highlight Elasticity and click Elastic.  Enter values of Young’s 

Modulus = 30E06 psi, and Poisson’s Ratio = 0.3. After the material properties have been 

entered, the Edit Material dialog box should look identical to Figure 6b.  

 Click OK. 

                                             

                             Figure 6a. Edit Material Dialog Box  Figure 6b. Edit Material Dialog Box (STEEL) 
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 Please note there is no dropdown menu or feature in Abaqus that sets specific units.  All of the 

dimensions have been input in inches; therefore the respective Young’s Modulus units should 

be entered in psi (pounds per square inch).  The units chosen for the definition of the material 

properties should be consistent and dictate what units should be used for the dimensions of the 

structure.  

 At this point in preprocessing, the model should be saved. Click File then click Save. Name the 

file Truss Tutorial. The file will save as a Model Database (*.cae*) file. It may be of interest to 

save the file after each section of this tutorial.  

Creating Sections 

 To create a truss section in Abaqus, double click Sections in the model tree and the Create 

Section dialog box will appear (Figure 7a). Enter a Name for the section (TRUSS), and choose 

Beam under the Category Tab, and Truss under the Type tab. Your Create Section dialog box 

should look identical to that in Figure 7b.  

 Click Continue…  

                                                                       

                Figure 7a.  Create Section Dialog Box      Figure 7b. Create Section Dialog Box Truss 

 The Edit Section dialog box will then appear where a Material and Cross-Sectional area can be 

defined for this section.  Because only one material has been created, the Material is defaulted 

to STEEL. If multiple materials had been created, the dropdown menu could be used to 

prescribe a different material to this section.  

 Enter 12.566 for the Cross-Sectional area (This value accounts for a 2-in. radius rod, i.e. πr2). The 

Edit section dialog box should look identical to that in Figure 8. 

 Click OK. 

 

Figure 8. Edit Section Dialog Box (TRUSS) 
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Assigning Sections 

 Now that the truss sections have been created, they can be assigned to the geometry. In the 

model tree, click the + to the left of the Parts icon, this will further expand the model tree’s 

options. Next, click the + to the left of the part called TRUSS, further expanding the model tree 

(Figure 9). 

 

Figure 9. Model Tree Expansion (Parts) 

 After the model tree has been expanded, double click Section Assignments. Use the cursor to 

select all of the lines by holding down the left mouse key and draging the cursor around the 

truss to create a box around the whole model. If this drag has been done correctly, the model 

will change color from grey to red. Click Done.  

 The Edit Section Assignment dialog box will appear (Figure 10). Because only one section has 

been created, the dropdown menu defaults to the TRUSS section. If multiple sections had been 

created, the dropdown menu could be used to assign different sections to different parts of the 

geometry.  

 Click OK. The model now should now turn to a blue color. 

 

Figure 10. Edit Section Assignment Dialog Box (TRUSS) 
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 Finally, a Beam Section Orientation must be assigned. In the toolbar at the top of the Viewport, 

there is a dropdown menu labeled Assign. Using the left mouse button, click Assign and click 

Beam Section Orientation (Figure 11).  

 

Figure 11. Beam Section Orientation Drop down Menu 

 Using the cursor, hold the left mouse button while dragging the cursor around the model to 

create a box around the whole geometry. If this drag is done correctly, the model will change 

color from blue to red.  

 Click Done. 

 Using the computer keyboard, hit Enter. The model should look identical to Figure 12. 

 

Figure 12. Beam Section Orientation 

 Hit OK. 

 Click Done. The model should turn back to a blue color. 

 This last step is used to define the orientation of a beam in space.  Because the current model is 

using truss elements, this orientation is not critical, so we accept the default definition.  
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However, if we were using beam elements, then we would need to be careful in defining this 

orientation. 

Creating a Mesh 

 To create a mesh for the model geometry, double click Mesh (Empty) in the model tree.  If this 

selection is done correctly, then the geometry should change color to pink. 

 The first step in creating a mesh is to seed the part. Click the Seed Part icon  in the mesh 

module and you will be prompted by the Global Seeds dialog box (Figure 13a). Change the 

Approximate global size to 20 and click Apply. The Global Seeds dialog box should look identical 

to  Figure 13b. 

 Click OK. 

                  

Figure 13a. Global Seeds Dialog Box            Figure 13b. Global Sees Dialog Box (20) 

 Now that the part has been seeded, a mesh can be generated. Click the Assign Element Type 

icon  in the mesh module.   

 Using the cursor drag the mouse while holding the left mouse key down to create a box around 

the whole geometry. If this drag is done correctly, then the part will turn from pink to red 

(Figure 14).  
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Figure 14. Assign Element Type 

 Click Done. You will be immediately prompted by the Element Type dialog box. Under the 

Family category scroll down and choose Truss. Your Element type dialog box should look 

identical to Figure 15. 

 

Figure 15. Element Type (Truss) 

 Click OK.  

 Click Done 

 Note:  The T3D2 element type code implies:  T=Truss element class, 3D=three-dimensional and 

2=two noded element. 
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 The part is now ready to be meshed. In the mesh module, click the Mesh Part icon  . At the 

bottom of the viewport you will be prompted if it is OK to mesh the part? Click Yes. 

 If this procedure was done correctly, the geometry will turn blue (Figure 16). 

 

Figure 16. Meshed Geometry 

Creating an Instance 

 Now that the part has been meshed, it can be brought into the assembly. To do this task, click 

the + to the left of Assembly in the model tree. The model tree will expand and should look 

identical to Figure 17.  

 

Figure 17. Model Tree Expansion (Assembly) 

 Double click on the Instances icon in the expanded model tree. This feature will allow multiple 

parts to be brought into the assembly.  The Create Instance dialog box will appear (Figure 18).  
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Figure 18. Create Instance Dialog Box 

 The TRUSS part is selected by default because only one part has been created for this tutorial. If 

multiple parts had been created, then this step would allow them to be entered into the 

assembly.  

 Click OK. If this step was done correctly the model should turn a blue color (Figure 19). 

 

Figure 19. Create Instance  

Creating a Step 

 A Step is where the user defines the type of loading, e.g. Static or Dynamic, and defines the 

boundary conditions, e.g. support constraints and forces. 

 In the model tree, double click the Steps icon. The Create Step dialog box will appear 

(Figure 20a). Create a Name for the step called TRUSS STEP. Under Procedure type choose 

General > Static, General. The Create Step dialog box should look identical to Figure 20b. 
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                   Figure 20a. Create Step Dialog Box                  Figure 20b. Create Step Dialog Box (TRUSS STEP) 

 Click Continue…, and the Edit Step dialog box will immediately appear (Figure 21). 

 

Figure 21. Edit Step Dialog Box 

 Click OK to accept the default values for the various options. 

Apply a Load Boundary Condition 

 A force of Fx=1000 lbs will be applied to the top node. Double click the Loads icon  

in the model tree. The Create Load dialog box will appear (Figure 22a).  

 Create a name for the load called LOAD and ensure that TRUSS STEP is selected for the Step. 

Choose Mechanical under the Category option and Concentrated force under the Types for 

Selected Step option. The Create Load dialog box should look identical to that in Figure 22b. 
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                Figure 22a.  Create Load Dialog Box                    Figure 22b. Create Load Dialog Box (LOAD) 

 Click Continue… 

 At this point all of the available nodes on which the concentrated force can be applied will turn 

the color yellow. Using the cursor click on the top node of the structure. If this selection is done 

correctly, the node color will turn from yellow to red (Figure 23). 

\  

Figure 23. Concentrated Force on Top Node 

 Click Done. The Edit Load dialog box will immediately appear (Figure 24a). Enter a value of 1000 

into the CF1 option. This entry will apply a load of 1000 lbs in the positive X direction. The Edit 

Load dialog box should look identical to that in Figure 24b. 
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                 Figure 24a. Edit Load Dialog Box                          Figure 24b. Edit Load Dialog Box (1000) 

 Click OK. If this step was done properly, then a small yellow arrow will appear at the node where 

the force was applied and points in the positive X direction (Figure 25). 

 

Figure 25. 1000-lb Load 
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Apply Constraint Boundary Conditions 

 Two different boundary conditions must be applied to this model. As shown in Figure 1, the left 

side of the structure is constrained by a roller support, while the right side is constrained by a 

pinned support.  

 Double click the BCs icon in the model tree and the Create Boundary Condition dialog box will 

appear (Figure 26a). Create a Name for the boundary condition called ROLLER, under the 

Category option choose Mechanical, and choose Displacement/Rotation under the Types for 

Selected Step option. The Create Boundary Condition dialog box should look identical to that in 

Figure 26b.   

                                              

      Figure 26a. Create Boundary Condition                      Figure 26b. Create Boundary Condition (ROLLER) 

 Click Continue… 

 All of the available nodes on which the boundary condition can be applied will turn the color 

yellow. Using the cursor, click bottom left node of the structure. If this selection is done 

correctly, then the node color will turn from yellow to red (Figure 27). 
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Figure 27. Boundary Condition (Roller) 

 Click Done.  

 The Edit Boundary Condition dialog box will immediately appear (Figure 28a). Check the boxes 

next to the U2 and the U3 options. This will constrain the structure in the Y and Z directions but 

allow movement in the X direction.  Note that the default value for the respective displacements 

is zero.  A nonzero displacement BC can be defined if needed.  

                                                                  

                Figure 28a. Edit Boundary Condition                 Figure 28b. Edit Boundary Condition (U2 U3) 

 Click OK. 
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 Repeat the same procedure to create the PINNED constraint boundary condition. However, 

name this boundary condition PINNED and apply the boundary condition to the bottom right 

node of the structure. Finally in the Edit Boundary Condition dialog box, check U1 U2 and U3 to 

constrain the X, Y, and Z directions, respectively.  

Creating a Job 

 To create a job for this model, double click the Jobs icon in the model tree. Up to this point, you 

have been preprocessing the model.  A job will take the input file created by the preprocessor 

and process the model, i.e. perform the analysis.  In the Create Job dialog box, create a Name 

for this job called TRUSS_TUTORIAL. Blank spaces are not allowed in a job name.  Thus the use 

of the underline in the name.  The Create Job dialog box should look identical to that in 

Figure 29. 

 

Figure 29. Create Job Dialog Box (TRUSS_TUTORIAL) 

 Click Continue… 

 The Edit Job dialog box will immediately appear (Figure 30).  

 

Figure 30. Edit Job Dialog Box 

 Accept the default values and click OK. 
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Setting the Work Directory 

 To ensure that the input files write to the correct folder, setting the work directory must be 

accomplished. At the top of the screen, click File and in the dropdown menu click Set Work 

Directory… (Figure 31). 

 

Figure 31. Set Work Directory 

 The Set Work Directory screen will immediately appear (Figure 32). Click Select… and use 

standard Windows practice to select (and possibly create) a subdirectory.  

 

Figure 32. Set Work Directory (FOLDERS) 

 Click OK.  

 Click OK. 
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Writing the Input File (.inp) 

 To write the input file of the job that was created, first click the + next to the Jobs(1) icon in the 

model tree. 

 Right click the job called TRUSS_TUTORIAL and click the Write Input option. This choice will 

write an input file (.inp) of this model to the work directory.  

 It may be helpful to go to the folder on the computer to which the work directory is set to 

ensure that the input file was written there.  

Model Analysis (Abaqus Command)   

 Method #1 

 Go to the Start Menu and open Abaqus Command 

 ABAQUS is set to a default directory (Example E:\>). To change directories in the Abaqus 

Command type the directory of choice followed by a colon (F:) then hit Enter. 

 To access a specific directory within that drive type cd followed by the specific folder name in 

that directory (e.g., cd APPLIED STRENGTHS T.A) then hit Enter. 

 Now that the correct directory has been sourced in the command window type abaqus inter 

j=TRUSS_TUTORIAL  and then hit enter. 

 If the job has completed successfully the Abaqus prompt should look similar to Figure 33. 

 

Figure 33.  Abaqus Command Prompt (COMPLETED) 
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 Method #2 

 An alternative method for submitting an *.inp file for processing by Abaqus can be accomplished 

with Abaqus/CAE. 

 Right click the job called TRUSS_TUTORIAL and click the Submit option. 

If you see a warning (Figure 34) Click OK.  The intent of this warning is to prevent the user from 

accidentally overwriting a previously completed analysis with the same name. 

 

 
Figure 34. Abaqus Warning 

 

 The model will now be submitted for analysis by Abaqus and the progress can be viewed in the 

status window at the bottom of the screen (Figure 35). 

 

 
Figure 35. Status Window 

 

Postprocessing using ABAQUS CAE 

 After the analysis has successfully completed in the Abaqus Command window using Method #1 

or using Method #2, return to view the Abaqus/CAE viewport.  

 Because the last step of creating the model was to create a job/write (and possibly submit) an 

input file, the TRUSS_TUTORIAL job should still be highlighted in Abaqus/CAE model tree. Right 

click the TRUSS_TUTORIAL and then click Results.  

 If this selection was done correctly, the model should turn to a green color and the truss will 

have rotated to an isometric view (Figure 36). 
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Figure 36. Analysis Results Isometric View 

 To rotate the truss back into the X Y plane for viewing, click View in the toolbar at the top of the 

screen. Next, Click Toolbars and make sure the option Views has a check mark to the left of it.  If 

not, then click it.  

 The Views toolbar will appear (Figure 37), and the Apply Front View button can be clicked to 

view the model in the X Y plane.   

 

Figure 37. Views Toolbar 

 To view the deformed shape of the model, click the Plot Contours on Deformed Shape icon 

  in the Visualization module. The model should look similar to that in Figure 38. 
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Figure 38. Deformed Shape 

Obtaining Stress Values in Elements 

 To obtain the stresses in an element click the Create XY Data icon  in the Visualization 

module. The Create XY Data dialog box will appear (Figure 39a). Choose the ODB field output 

option (Figure 39b). 

                                  

             Figure 39a. Create XY Data Dialog Box                     Figure 39b. Create XY Data Dialog Box (FIELD) 

 Click Continue… 

 The XY Data from ODB Field Output dialog box will appear (Figure 40). Under the Variables tab 

click the black arrowhead next to S: Stress components.  This click will expand the selection for 
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more options.  Scroll down and check the box next to S11. All other stress components should 

be left unchecked.  

 

Figure 40. XY Data from ODB Field Output 

 Next click the Elements/Nodes tab. Make sure that Pick from viewport is selected in the 

Method section, and click Edit Selection.  

 While holding the Shift key on the keyboard, click the elements on the model for which the 

stresses are of interest. When the elements have been selected they will turn a red color.  

 Click Plot. 

 Click Dismiss. 

 A plot should appear similar to that in Figure 41. 
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Figure 41. Field Output Plot 

 To view the numerical values of the stresses in the elements, click the XY Data Manager icon 

  in the Visualization module. This option is located directly to the right of the Create XY 

Data option.  

 The XY Data Manager dialog box will appear (Figure 42).  

 

Figure 42. XY Data Manager Dialog Box 

 There are stress values for three elements because three were selected in the previous step. To 

view the value, double click each selection and an Edit XY Data dialog box will appear 

(Figure 43). 
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Figure 43. Edit XY Data Dialog Box 

 In this dialog box the value of the stress seen by this member is listed. Multiply the stress by the 

area to get the force in each element. 

Conclusion 

 Save the file by doing either File > Save or clicking the disk icon (Figure 44). 

 
Figure 44. Save File 

 

 Close Abaqus/CAE:  File > Exit or Ctrl+Q 

 This completes the Finite Element Analysis of a Planar Truss tutorial.  


